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Pixlr: Basic Photo Editing 

When starting at Pixlr.com you have two options for editing 

or creating pictures. Pixlr Editor is a full-featured photo 

editing suite and Pixlr Express is a streamlined editor with 

less features but is still useful for quick changes. Both are 

located at www.Pixlr.com. 

For this class we’ll be using and discussing the Pixlr Editor. 

Everything we cover in this class can be applied to Pixlr 

Express but you’ll find some of what we cover is not in 

Express and that the tools that are there will look different. 

 

 

When you select the Editor you’ll get a few options to start with. 

You can create a new image from scratch, open an image that is on your 

computer, import an image using a URL you have copied, or if you have an 

account with Pixlr you can open an image you have uploaded with them using 

their Library feature. 

For this class we’ll practice creating an image from scratch, we’ll try editing an 

image we have saved to our computer and we’ll practice importing an image 

using a URL. 
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The above images show the windows that open when you select CREATE A NEW IMAGE (on the left) or OPEN AN IMAGE FROM YOUR 

COMPUTER (on the right). 

When you CREATE A NEW IMAGE you are given some options to start with. You can start by naming the file and selecting the size of the 

“canvas” you’ll be starting with (you can change this later as well). The canvas, named after what you would paint on in real life, is sized using 

pixels (the tiny parts of the screen that make up the larger picture). You can find tools online that can help convert pixel measurements into 

inches. 

Tip: It’s always better to start big and make your image smaller later.  The way computers work making a large image smaller will keep the 

picture looking nice, but if you try to make a small image larger the image will look fuzzy because the fine details are not in the image. Sadly we 

cannot enhance photos and images like they do in TV and movies. 

When you select OPEN AN IMAGE FROM YOUR COMPUTER you get a window that allows you to find files from your computer. Finding the file 

depends on how you like to store your images on your computer. Maybe you like to have one folder with all of your images, or you like to keep 

the image you want to work with on the desktop so it’s easy find. There’s no wrong way to go about this, it’s whatever works best for you. 
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Here is a view of what the Editor looks like in your web browser. In this image you’ll see the canvas which is the large blank screen in the middle. 

Around it are other windows:  

On the left is the Tools window: This window contains most of the tools normally associated with editing an 

image. If you’ve ever used Microsoft Paint you’ll have seen many of these tools.  

Top right is the Navigator window: This window allows you to zoom in and out on the canvas as well as help 

you move around to different parts of the image as you’re zoomed in. This is useful for doing detailed work 

where you need to be zoomed in extremely close. 

Middle right is the Layers window: Layers are like putting different sheets of invisible paper on top of your 

image. This allows you to add elements to your image without affecting the actual image at first. 

Bottom right is the History window: History allows you to go forward or backwards with your changes. It’s like 

undo and redo but more powerful.  
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1 – Crop Tool: Reframe your entire canvas to a desired size 
and remove everything else.  

15 – Move Tool: This lets you move whatever you've 
selected around the canvas. 

2 – Marquee Tool: Use this to select rectangular areas of a 
layer or the canvas.  

16 – Lasso Tool: A free-hand version of the marquee tool.  

3 – Wand Tool: Will make a marquee-style selection based 
on values (i.e., tone and color) that are similar to the area 
clicked.  
 

17 – Brush Tool: Much like the pencil, the brush lets you 
draw freehand, but with many more options. 

 4 – Pencil Tool: Draw on an image or layer free hand. 18 – Paint Bucket Tool: Dump a big mess of color onto a 
layer or on your background. If you want more control 
over how messy that paint dump is, adjust the tolerance. 

5 – Eraser Tool: Use the erase tool to remove details. You 
can also erase details from a specific layer. 

19 – Clone Stamp Tool: Lets you sample pixels in one 
defined area and replicate those pixels elsewhere 

6 – Gradient Tool: Use this tool whenever you want to 
create a gradient — a gradual colored shading — of two 
colors. 

20 – Drawing Tool: Use this to create basic geometric 
shapes like lines, rectangles, rounded, rectangles, and 
ellipses. 

7 – Color Replace Tool: Replaces areas under your brush 
with a new, desired color — while preserving the 
underlying texture and shadows. 

21 – Sharpen Tool: Sharpening increases the contrast 
between pixels, which has the visual effect of bringing out 
details and highlights. 

8 – Blur Tool: Make things blurry. 
 

22 – Sponge Tool: Enhances or sops up color, depending 
on your settings. 

9 – Smudge Tool: Effectively combines pixels of different 
colors to produce an effect that can look like smudged 
paint. 

23 – Burn Tool: The opposite of dodging, burning lets you 
darken an area. 

10 – Dodge Tool: Use the dodge tool to lighten specific 
areas. 

24 – Spot Heal Tool: Can help remove scratches or 
blemishes by simply clicking on the area. 

11 – Red Eye Reduction Tool: Easily corrects the 
annoyingly common red-eye effect. 

25 – Pinch Tool:  Lets you distort an area as if it were being 
seen through a concave lens. 

12 – Bloat Tool: Lets you distort an area as if it were being 
seen through a convex lens. 

26 – Type Tool: Lets you add characters, letters, words, 
numbers, etc. 

13 – Colorpicker Tool: Lets you sample colors from your 
image for use with other tools. 

27 – Zoom Tool: Using zoom, you can either click to zoom 
or draw a rectangular area to zoom into. 

14 – Hand Tool: Use the hand tool to move your image 
around, especially useful if you are zoomed in. 

28 – Set Main Color: Your color palette contains the color 
you're currently working with. 
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Edit Menu 

The Edit Menu contains a few important tools, but the most important ones can be 

accessed by hotkeys (keyboard shortcuts). 

Undo and Redo are useful but are not as powerful as using the History window to 

go back through changes. Think of these as quick help features if you don’t like 

what you just did. 

Cut, Copy, Clear, and Paste are all pretty standard, Clear being the kind of odd one 

out, it deletes what you have selected. You’ve likely used these in other programs. 

Free transform allows you to rotate and manipulate the size of the image.          

Free distort allows you to pull and fold the image using the four corners of the 

image. 

Define brush allows you to make custom brushes. Think of this more as a stamp 

you’ve made that you can use as you need. 

 

Image Menu 

In the Image Menu options you’ll find ways to resize the image as well as the 

canvas. The image size is the size of the image you’re working on, but the canvas 

size is the area you have to work on. Think about the image being what you would 

paint and the canvas is what you paint on. 

You also have options to rotate the canvas by set degrees. You can also flip the 

canvas on the vertical or horizontal axis. Imagine this as putting the image to a 

mirror. 
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Layer Menu 

The Layer Menu is where you are able to manipulate layers. Layers 

as we mentioned are different levels or sheets of invisible paper to 

work on. If it makes more sense think of them as tracing paper or 

the plastic sheets people used to use on overhead projectors. 

This menu gives you the option of opening a new image directly 

into the one you’re working on as a new layer. This is nice if you 

don’t want to open a bunch of images in different windows. 

Merge and Flatten are nice when you’re towards the end of your 

work or if you want to place two or more layers together so you can 

edit what’s on them as one single layer. 

Moving layers up or down is adjusting where they are in the stack 

of layers. If one layer is on top of another its content will cover what 

is below it. 

Layer styles give you a few options to stylize the layer you’re 

working on. It’s best to play around with the styles to learn about 

them. 

Tip: Rasterize layer and masks are a little beyond the scope of this 

class. We recommend checking out video tutorials on YouTube as 

these are more complicated. 

Rotating and flipping layers works the same as if you were rotating 

or flipping the canvas, but you’re only manipulating the layer you’re 

currently working on instead of the whole project. 

Tip: The first layer in every image is called “Background” and is locked for editing; double click the lock icon by the layer to edit it. It’s now called 

“Layer 0.” 
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Adjustment Menu and Filter Menu 

It’s helpful to talk about these two menus together because there’s really a lot of overlap 

in what they do, but they use different names. A filter is just a set way to adjust the image 

and in the Adjustment menu you’ll find what are essentially filters under the names: 

Invert, Sepia, Solarize, Desaturate, Old photo, and Cross process. 

Under Adjustment you’ll find other useful tools you might be familiar with, such as 

Brightness & Contrast or Hue & Saturation, if you’ve ever adjusted your computer 

monitor. The other tools are a bit complicated to explain briefly here so again we suggest 

playing around with them or watching more in-depth tutorials on YouTube. 

Tip: The Filter menu gives you a wide range of fun ways to adjust your image. There are too many to explain here and the best way to learn 

them is to play with them. 
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View, Language and Help 

A few key things to point out here are: 

- Actual pixels: This will increase the size of 

your image to the full size it is based on how many 

pixels are in it. 

- Navigator, Layers, History and Tool options 

refer to the windows that the name corresponds to; 

this is important to know if you accidently close one of 

these windows and want to open it again. 

- Reset palette location will move all the 

windows to the original placement they’re found in 

when you launch Pixlr. 

Language is where you would go to adjust the 

language Pixlr is in. If you’re more comfortable with another language than English, Pixlr is available in several languages to meet your needs. 

Last but not least is Help. Like all good programs, Pixlr features a help menu. The options included here are: Help which will take you to the full 

Help website for Pixlr, FAQ which links you to the Frequently Asked Questions page of the Pixlr help page, API which will link you to information 

on how to embed Pixlr on your own website, Blog will take you to the blog page for Pixlr and Contact will take you to the page with contact 

information for Pixlr customer support. 

Saving 

Now that we’ve finished editing our photo it’s time to save our work. When you click save you’re given several options.  You can add a name to 

the image, select the image format, and with a jpeg you can adjust the quality (this changes the file size and how much detail is kept when 

saving. 

File formats explained: JPEG is the most standard image, it’s good for uploading to the internet; PNG allows you to keep an image with a 

transparent background, useful for logos; BMP is a larger file with better quality than a JPEG; TIFF is the highest quality format, it’s good for 

posters and photos you’d like to print; and PXD is a Pixlr format that allows you to keep layers, this is good if you want to work on an image later. 


